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In diesem Handbuch...
In diesem Handbuch wird beschrieben, wie Sie die ChemStation-Software 
installieren, wie weitere Gerätemodule in ein bestehendes System 
eingebunden werden, wie das Analysensystem konfiguriert wird und 
wie Sie überprüfen können, ob Installation und Konfiguration vollständig 
und funktionsfähig sind.

Dieses Handbuch enthält folgende Kapitel:

1 - Vorbereitung der Installation - Dieses Kapitel enthält einen Überblick 
über die ChemStation von Agilent Technologies. Es listet die PC- 
und Upgrade-Anforderungen sowie Informationen zur 
Gerätekommunikation auf.

2 - Installation der Agilent ChemStation - In diesem Kapitel werden die 
Verfahren zur Installation und Aktualisierung der Agilent 
ChemStation-Software beschrieben. 

3 - Gerätekonfiguration - In diesem Kapitel wird beschrieben, wie der 
Konfigurationseditor für die Konfiguration der Geräte verwendet 
wird.

4 - Validierung und Starten der Agilent ChemStation - In diesem Kapitel 
wird beschrieben, wie Sie die Agilent ChemStation-Software 
validieren und mit ihr arbeiten.

5 - Zusätzliche Ressourcen - Dieses Kapitel enthält einen Überblick über 
die zusätzlichen Agilent ChemStation-Ressourcen, die Sie auf der 
Agilent ChemStation-DVD und im Internet finden.

In diesem Handbuch wird Folgendes vorausgesetzt:

• Sie sind mit der Verwendung des Betriebssystems Microsoft® Windows XP 
Professional oder Microsoft® Windows Vista™ Business vertraut.

• Sie installieren die Software auf einem PC, der die 
Hardware-Mindestanforderungen erfüllt.

• Ihre Geräte und Kommunikationsgeräte sind mit dieser Version 
der Agilent ChemStation kompatibel.

Die Agilent ChemStation-Software kommuniziert über LAN oder 
GPIB-Datenkommunikation mit den Analysengeräten.
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1 Vorbereitung der Installation

PC-Anforderungen

Mindestanforderungen an die Hardware für die Agilent Technologies 
ChemStation-Software (Version B.04.02):
• Ein PC mit einem Intel Pentium IV-Prozessor  

(1,5 GHz für Microsoft Windows XP Professional) 
(3,4 GHz [Single Core] für Microsoft Windows Vista)

• 1280 x 1024 Super VGA-Anzeige, 16.000 Farben oder mehr

• 40 GB Festplatte für Microsoft Windows XP Professional, 160 GB 
Festplatte für Microsoft Windows Vista

• DVD-Laufwerk

• 512 MB Arbeitsspeicher für Microsoft Windows XP Professional, 1 GB 
für Microsoft Windows Vista

• Microsoft Windows-kompatibles Zeigegerät

• Betriebssystem-kompatibler Drucker. Englisches System: Drucker mit PCL 
5c, 5e, 5e, 5.02 oder 6. Chinesisches System: Drucker mit PCL 6. 
Japanisches System: Weitere Informationen finden Sie in Tabelle 1.

• Microsoft Windows XP Professional (Service Pack 3) oder Microsoft 
Windows Vista Business (Service Pack 1) als Betriebssystem (nur Englisch, 
Chinesisch und Japanisch). 

• Installiertes TCP/IP-Protokoll, sofern Sie die LAN-Kommunikation verwenden

• 82357B USB GPIB-Adapter oder die 82350B PCI GPIB-Karte und die 
I/O Library Suite 15.0 für die GPIB-Kommunikation. Anweisungen zur 
Installation der Agilent IO Library Suite finden Sie im Verzeichnis 
„Manuals“ der ChemStation-DVD.

Die gesamte PC-Hardware und alle Peripheriegeräte müssen in der Hardware 
Compatibility List (HCL) von Microsoft enthalten sein, die auf der 
Microsoft-Homepage unter http://www.microsoft.com verfügbar ist. Ist die 
Hardware Ihres Computers nicht in der HCL-Liste aufgeführt, wird die Agilent 
ChemStation-Software auf Ihrem System möglicherweise nicht korrekt arbeiten.

Computer anderer Hersteller

Die Agilent ChemStation wurde für den sicheren Betrieb auf verschiedensten 
PCs entwickelt und ist mit Zubehör und Peripheriegeräten ausgestattet, die 
dem Programmierungsstandard für die Intel PC-Plattform und für Microsoft 
Windows-Betriebssysteme entsprechen. 
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Agilent hat die Tests der Agilent ChemStation-Software jedoch hauptsächlich 
auf Geräten von Hewlett-Packard (HP)/Compaq durchgeführt. So könnte 
beispielsweise die Standardeinstellung der GPIB-Schnittstelle zu Problemen 
mit der Speicherkonfiguration von Computern anderer Hersteller als HP führen. 
Zusätzliche Zubehör-Schnittstellenkarten können Konflikte mit anderen mit 
Hardware zusammenhängenden Ressourcen (z. B. I/O-Anschlüsse, 
Interrupt-Einstellungen und DMA Kanäle) verursachen. 

Verwenden Sie bei Computern anderer Hersteller als HP das mitgelieferte 
Dienstprogramm zur Konfiguration des Computers. Überprüfen Sie die im 
Lieferumfang des Computers enthaltene Dokumentation und eventuelles 
Zubehör, um Ressourcen-Konflikte bei der Konfiguration des PCs zu 
verhindern, vor allem in Hinblick auf die GPIB-Schnittstelle.

Drucker für die Agilent ChemStation

Die Agilent ChemStation arbeitet mit Druckern, die mit dem Betriebssystem 
kompatibel sind. Die Drucker können lokal (vorzugsweise parallel) oder 
an den Netzwerkanschluss des Computers angeschlossen werden. Serielle 
Druckerschnittstellen werden zwar vom Betriebssystem unterstützt, aber 
die Geschwindigkeit ist möglicherweise beeinträchtigt. Drucker im Netzwerk 
müssen von einem Netzwerk-Server aus betrieben werden, dessen Netzwerk 
vom Microsoft-Betriebssystem unterstützt wird. Es wird die Verwendung 
von Druckertypen empfohlen, die eine Esc-Code-Sprache (wie PCL) oder 
eine Seitenbeschreibungssprache (wie Postscript®) verstehen. Hostbasierte 
Drucker (z. B. Graphics Device Interface [GDI]- oder Printer Performance 
Architecture [PPA]-Drucker) belasten die CPU mit mehr Druckertasks und 
werden daher nicht für die Online-Arbeit mit der Agilent ChemStation 
empfohlen. 

Die besten Druckergebnisse mit Ihrer Agilent ChemStation erzielen Sie mit 
HP LaserJet-Druckern (siehe Tabelle 1). High Performance HP DeskJet-Drucker 
können auch verwendet werden, wenn der erforderliche Druckumfang gering 
ist. Zusätzliche Informationen zu empfohlenen Versionen der jeweiligen 
Druckertreiber finden Sie in der Datei „readme.txt“. Agilent hat nicht alle 
Kombinationen von Druckern und Druckertreibern getestet, die von Windows 
unterstützt werden. Leistungsfähigkeit und Qualität des Ausdrucks können bei 
Druckern anderer Hersteller variieren.
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Tabelle 1 Drucker, die mit der Agilent ChemStation B.04.02 erfolgreich getestet wurden

Drucker Modell Treiber

HP LaserJet 4050 und 4100 HP PCL 5e- oder PCL 6-Treiber

HP LaserJet 4200 HP PCL 5e- oder PCL 6-Treiber

HP LaserJet 4250 HP PCL 6-Treiber

HP LaserJet P3005D HP PCL 6-Treiber

HP Color LaserJet 2500TN HP PCL 6-Treiber

HP OfficeJet Pro K550DTWN HP PCL 3-Treiber

HP OfficeJet Pro K5400

HP LaserJet 2200D HP PCL 5.02- oder PCL 6-Treiber

HP LaserJet 2300DN HP PCL 5e- oder PCL 6-Treiber

HP LaserJet 2420D HP PCL 6-Treiber
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Allgemeines zum LAN

Die Agilent ChemStation-Software verwendet das TCP/IP-Protokoll, 
das als Netzwerkprotokoll auf dem PC installiert sein muss. 

Wenn Sie ein Agilent 6890 Plus, 6890A oder 35900E steuern, benötigen die 
J4100A JetDirect- und G1369A-LAN-Karten, die für den Anschluss dieser 
Analysengeräte an ein LAN verwendet werden, das Bootstrap-Protokoll 
(BootP). Agilent unterstützt nur den Agilent BootP-Dienst, der mit der 
ChemStation-DVD geliefert wird.

Version B.04.02 der Agilent ChemStation-Software bietet LAN-basierte 
Gerätesteuerung und -Datenerfassung für LAN-fähige Agilent GC-Systeme und 
A/D-Controller. Sie können die Geräte problemlos steuern und überwachen, 
wenn Sie sie an ein LAN anschließen, in dem sich der Agilent ChemStation-PC 
befindet. Dadurch kann der Agilent ChemStation-PC in einem von Agilent 
unterstützten, eigenständigen LAN bis zu 100 Meter von den Geräten entfernt 
sein, die er steuert. Wenn er sich in einem TCP/IP-basierten Netzwerk 
befindet, ist sein Standort weltweit frei wählbar.

Jede Agilent ChemStation kann bis zu vier Geräte im LAN steuern. Jedes 
Gerät im LAN erfordert eine eindeutige IP-Adresse, eine Subnetzmaske und 
ein Standard-Gateway.

Für die Installation einer Agilent ChemStation in einem Standort-LAN 
wenden Sie sich an den LAN-Administrator des Standorts.

Agilent ChemStation unterstützt Geräte und PCs mit selbst zugewiesenen, 
statischen Adressen oder mit Adressen, die vom Agilent BootP-Dienst 
zugewiesen wurden (siehe „Agilent BootP-Dienst installieren“  auf Seite 18). 
DHCP wird von Agilent nicht unterstützt.
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Gerätekommunikation

Agilent ChemStation kommuniziert mit den GCs entweder über eine LAN- 
oder eine GPIB-Kommunikationsschnittstelle (GPIB = General Purpose 
Interface Bus).

Stellen Sie sicher, dass der Kommunikationskanal zwischen dem Gerät und 
dem PC vor Inbetriebnahme des Systems eingerichtet ist. 

Weitere Informationen zum Installieren einer LAN-Karte auf Ihrem PC oder 
auf einem von der Agilent ChemStation gesteuerten Gerät finden Sie in der 
Dokumentation der entsprechenden LAN-Karte.

LAN-Kommunikation

Weitere Informationen zum Einrichten der erforderlichen Kommunikations- 
Hardware und -Software für Ihr System finden Sie auf der in Tabelle 2 
angegebenen Seite.

Tabelle 2 Von der Agilent ChemStation unterstützte LAN-Kommunikationsschnittstellen 

Gerätetyp Modell
Unterstützte 
Firmware-Version

Unterstützte IP- 
Adressierungs- 
methode Siehe:

7890A G3440A A.01.10.1 Wird auf dem 
GC festgelegt

Seite 14

6890N GC G1530N/ 
G1540N

N.06.05 für 7693A oder 
N.05.06  
(LAN-Assembly 04.7B3)

Wird auf dem 
GC festgelegt 

Seite 15

6890 Plus, 6890A G1530A/ 
G1540A

A.03.08 Agilent 
BootP-Dienst

Seite 21

6850 GC  
SN ≥ US10243001

G2630A N.06.03 für 7693A oder 
A.05.04 
(LAN-Assembly 04.7B3)

Wird auf dem 
GC festgelegt

Seite 16

6850 GC  
SN ≤ US00003200

G2630A A.03.05 für 7693A oder 
A.03.03

Wird auf dem 
GC festgelegt oder 
über den Agilent 
BootP-Dienst 

Seite 16 
Seite 21

35900E 35900E E.01.02 Agilent 
BootP-Dienst

Seite 21
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GPIB-Kommunikation

Analysengeräte, die mit der Agilent ChemStation via GPIB kommunizieren, 
benötigen eine auf Ihrem Computer installierte GPIB-Karte. In Tabelle 3 
finden Sie eine Liste der Gerätetypen, die die GPIB-Kommunikation 
zusammen mit der unterstützten 82350B-Schnittstellenkarte und der 
82357B USB-GPIB-Schnittstelle verwenden.

Weitere Informationen zum GPIB-Hardware-Setup finden Sie unter „Die Agilent 
GPIB-Schnittstellenkarte installieren und konfigurieren“  auf Seite 26. Weitere 
Informationen zum Installieren und Einrichten der Agilent IO Library Suite 15.0 
finden Sie im Handbuch „Installation and Configuration Instructions“, das auf 
der ChemStation-DVD im Ordner „Support\Manuals\Installation“ enthalten ist.

Tabelle 3 GPIB- und Analysengeräte-Kompatibilität 

Gerätetyp Modell Unterstützte Firmware-Version
Agilent
82357B

Agilent 
82350B

6890 Plus, 6890A G1530A/ 
G1540A

A.03.08 Ja Ja

5890 Serie II 5890 A.03.02 Ja Ja

4890D G2690A A.01.01 Ja Ja

7890A Nein Nein

6850 Nein Nein

6890N Nein Nein

35900E Nein Nein
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Festlegen von IP-Adressen am GC

In diesem Abschnitt wird beschrieben, wie man die IP-Adresse eines GCs über 
die GC-Tastatur festlegen kann. Weitere Informationen zur Einrichtung von 
IP-Adressen für GCs, die diese Funktion nicht unterstützen, finden Sie unter 
„Agilent BootP-Dienst installieren“  auf Seite 18.

IP-Adresse für den Agilent 7890A GC konfigurieren

Die folgenden Schritte gelten für das Agilent 7890A GC-System.

1 Drücken Sie auf der 7890A-Tastatur Options (Optionen). Blättern Sie 
zu Communication (Kommunikation) und drücken Sie die Eingabetaste. 
Der folgende Bildschirm wird angezeigt:

COMMUNICATION SETPTS 
---- LAN ---- 
IP: 000.000.000.000 
GW: 000.000.000.000 
SM: 000.000.000.000 
Enable DHCP OFF 
Reboot GC 
Mac Address

2 Geben Sie die Ziffern der IP-Adresse des 7890A GC durch Punkte getrennt ein 
und drücken Sie die Eingabetaste.* Auf dem GC werden Sie in einer Meldung 
aufgefordert, das Gerät aus- und wieder einzuschalten. Schalten Sie das Gerät 
jedoch noch nicht sofort aus und wieder ein. Drücken Sie Clear (Löschen).

3 Wechseln Sie zu GW. Geben Sie die Gateway-Nummer ein und drücken Sie 
die Eingabetaste. Auf dem 7890A werden Sie in einer Meldung aufgefordert, 
das Gerät aus- und wieder einzuschalten. Schalten Sie das Gerät jedoch 
noch nicht sofort aus und wieder ein. Drücken Sie Clear (Löschen).

4 Blättern Sie zu SM und drücken Sie Mode/Type (Modus/Typ). Blättern Sie 
in der Modusliste zur entsprechenden Subnetzmaske und drücken Sie die 
Eingabetaste. Auf dem 7890A werden Sie in einer Meldung aufgefordert, 
das Gerät aus- und wieder einzuschalten. Schalten Sie das Gerät jedoch 
noch nicht sofort aus und wieder ein.

* Wenn Sie die Einstellungen für die IP-Adresse, das Gateway oder die Subnetzmaske des Agilent 
ChemStation-Computers nicht kennen, empfiehlt Agilent, die Standard-IP-Adresse des Computers 
auf 10.1.1.100, die IP-Adresse des GC- oder A/D-Steuermoduls auf 10.1.1.101 bis 10.1.1.105, die 
IP-Adresse des Standard-Gateways auf 10.1.1.100 und die IP-Adresse der Subnetzmaske auf 
255.255.255.0 zu setzen.
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5 Blättern Sie zu Reboot GC (GC neu starten) und drücken Sie On/Yes (Ein/Ja), 
um das Gerät aus- und wieder einzuschalten, sodass die Karte die 
LAN-Sollwerte übernimmt.

6 Drücken Sie Options (Optionen). Blättern Sie zu Communications 
(Kommunikation) und drücken Sie die Eingabetaste. Stellen Sie sicher, dass 
die richtigen Sollwerte vorhanden sind.

IP-Adresse für den Agilent 6890N GC konfigurieren

Dieses Verfahren betrifft den Agilent 6890N GC (mit LAN-Assembly).

1 Drücken Sie auf der 6890N-Tastatur Options (Optionen). Blättern Sie zu 
Communication (Kommunikation) und drücken Sie die Eingabetaste. Der 
folgende Bildschirm wird angezeigt: 

COMMUNICATION SETPTS 
---- LAN ---- 
IP: 000.000.000.000 
GW: 000.000.000.000 
SM: 000.000.000.000 
Enable DHCP OFF

---- RS-232 ----

2 Geben Sie die IP-Adresse für Ihren 6890N ein. Geben Sie die Ziffern durch 
Punkte getrennt ein und drücken Sie die Eingabetaste.* Auf dem GC werden 
Sie in einer Meldung aufgefordert, das Gerät aus- und wieder einzuschalten. 
Schalten Sie das Gerät jedoch noch nicht sofort aus und wieder ein. 
Drücken Sie Clear (Löschen).

3 Wechseln Sie zu GW. Geben Sie die Gateway-Nummer ein und drücken Sie 
die Eingabetaste. Auf dem 6890N werden Sie in einer Meldung aufgefordert, 
das Gerät aus- und wieder einzuschalten. Schalten Sie das Gerät jedoch 
noch nicht sofort aus und wieder ein. Drücken Sie Clear (Löschen).

4 Blättern Sie zu SM und drücken Sie Mode/Type (Modus/Typ). Blättern Sie in 
der Modusliste zur entsprechenden Subnetzmaske und drücken Sie die 
Eingabetaste. Auf dem 6890N werden Sie in einer Meldung aufgefordert, das 
Gerät aus- und wieder einzuschalten.

* Wenn Sie die Einstellungen für die IP-Adresse, das Gateway oder die Subnetzmaske des Agilent 
ChemStation-Computers nicht kennen, empfiehlt Agilent, die Standard-IP-Adresse des Computers 
auf 10.1.1.100, die IP-Adresse des GC- oder A/D-Steuermoduls auf 10.1.1.101 bis 10.1.1.105, die 
IP-Adresse des Standard-Gateways auf 10.1.1.100 und die IP-Adresse der Subnetzmaske auf 
255.255.255.0 zu setzen.
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5 Schalten Sie das Gerät aus und wieder ein, damit die Karte die 
LAN-Sollwerte übernimmt.

6 Drücken Sie Options (Optionen). Blättern Sie zu Communications 
(Kommunikation) und drücken Sie die Eingabetaste. Stellen Sie sicher, dass 
die richtigen Sollwerte vorhanden sind.

IP-Adresse für den Agilent 6850 GC konfigurieren 

Dieses Verfahren betrifft den GC der Serie 6850 (mit LAN-Assembly).

1 Schalten Sie den GC aus.

2 Drücken Sie die Taste LOAD (LADEN), halten Sie sie gedrückt und schalten 
Sie den GC ein. Halten Sie die Taste LOAD (LADEN) so lange gedrückt, bis 
fünf Punkte auf dem Display angezeigt werden.

3 Wenn der GC gestartet wird, sollten Sie Folgendes sehen: 
 
DHCP MODE: 
DISABLED 
 
Wenn „DHCP MODE“ (DHCP-MODUS) nicht auf DISABLED, (DEAKTIVIERT) 
gesetzt ist, drücken Sie ▲ oder ▼ , um den Modus auf DISABLED 
(DEAKTIVIERT) zu setzen. Drücken Sie LOAD (LADEN), um mit dem 
nächsten Eintrag fortzufahren.

4 Auf dem Display wird nun Folgendes angezeigt: 
 
IP ADDRESS 
XXX.XXX.XXX.XXX 

5 Drücken Sie LOAD (LADEN), um die Werte für „IP ADDRESS“ 
(IP-ADRESSE) anzupassen. Drücken Sie ▲ oder ▼, um die Werte zu ändern, 
und drücken Sie LOAD (LADEN), um von einem Wert zum nächsten zu 
wechseln.* 

* Wenn Sie die Einstellungen für die IP-Adresse, das Gateway oder die Subnetzmaske des Agilent 
ChemStation-Computers nicht kennen, empfiehlt Agilent, die Standard-IP-Adresse des Computers 
auf 10.1.1.100, die IP-Adresse des GC- oder A/D-Steuermoduls auf 10.1.1.101 bis 10.1.1.105, die 
IP-Adresse des Standard-Gateways auf 10.1.1.100 und die IP-Adresse der Subnetzmaske auf 
255.255.255.0 zu setzen.
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6 Wenn Sie die Werte für „IP ADDRESS“ (IP-ADRESSE) eingegeben haben, 
wird auf dem Display Folgendes angezeigt: 
 
DEFAULT GATEWAY 
XXX.XXX.XXX.XXX 

7 Ändern Sie die Werte für „DEFAULT GATEWAY“ (STANDARD-GATEWAY) 
genauso wie die Werte für „IP ADDRESS“ (IP-ADRESSE).*

8 Ändern Sie die Werte für „SUBNET MASK“ (SUBNETZMASKE) auf dieselbe 
Weise.*

9 Schalten Sie das GC-System aus und wieder ein, damit die neuen 
Einstellungen wirksam werden.
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Agilent BootP-Dienst installieren

Die J4100A JetDirect- und G1369A-LAN-Karten, die für den Anschluss eines 
Analysengeräts an ein LAN verwendet werden, erfordern das Bootstrap- 
Protokoll. Agilent unterstützt nur den Agilent BootP-Dienst, der mit der 
ChemStation-DVD geliefert wird.

In diesem Abschnitt wird beschrieben, wie die Agilent BootP-Dienst-Software 
installiert wird. Der Agilent BootP-Dienst weist Adressen all jenen Geräten zu, 
die ihre eigene Adresse nicht selbst festlegen können.

Zweck

Der Agilent BootP-Dienst ermöglicht die zentrale Verwaltung der IP-Adressen 
für Agilent Geräte im LAN. Der Dienst läuft auf dem Geräte-LAN-PC, auf dem 
das TCP/IP-Netzwerkprotokoll ausgeführt wird. Auf diesem PC darf kein 
DHCP-Server ausgeführt werden.

Wenn ein Gerät eingeschaltet wird, fordert die Agilent JetDirect-Karte in dem 
Gerät eine IP-Adresse oder einen Host-Namen an und sendet dazu die eigene 
Hardware-Adresse als Kennung. Die Abfrage kann bis zu 5 Minuten dauern. 
Der Agilent BootP-Dienst beantwortet diese Anfrage und übergibt dem 
anfordernden Gerät eine zuvor definierte IP-Adresse und einen mit der 
Hardware-Adresse verbundenen Host-Namen.

Wenn das Gerät seine IP-Adresse und den Host-Namen erhält, stoppt es 
das Senden der Anforderung. Es behält die IP-Adresse so lange bei, wie es 
angeschaltet ist. Wenn das Gerät ausgeschaltet wird, verliert es seine 
IP-Adresse, sodass der Agilent BootP-Dienst jedes Mal gestartet werden 
muss, wenn das Gerät eingeschaltet wird. Da der Agilent BootP-Dienst im 
Hintergrund ausgeführt wird, erhält das Gerät seine IP-Adresse, sobald es 
eingeschaltet wird.

Adressen

Bevor Sie den Agilent BootP-Dienst installieren und konfigurieren, müssen Sie 
die IP-Adressen des Computers und der Geräte, die Subnetzmaske und das 
Gateway kennen (siehe Kapitel 1).
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Installation

Führen Sie zum Installieren des Agilent BootP-Diensts folgende Schritte aus:

1 Melden Sie sich als Administrator oder als Benutzer mit 
Administratorrechten an.

2 Schließen Sie alle Windows-Programme.

3 Legen Sie die DVD der Agilent ChemStation-Software in das DVD-Laufwerk 
ein. Wenn das Setup-Programm automatisch gestartet wird, klicken Sie auf 
Cancel (Abbrechen), um es zu stoppen.

4 Öffnen Sie den Windows-Explorer.

5 Doppelklicken Sie in der Agilent ChemStation-Software-DVD im Verzeichnis 
„BootP“ auf BootPPackage.msi.

6 Falls erforderlich, klicken Sie in der Taskleiste auf das Symbol Agilent 
BootP-Dienst...

7 Der Begrüßungsbildschirm wird angezeigt. Klicken Sie auf Next > (Weiter).

8 Der Bildschirm mit der Lizenzvereinbarung wird angezeigt. Lesen und 
akzeptieren Sie die Lizenzvereinbarung und klicken Sie anschließend 
auf Yes (Ja).

9 Klicken Sie auf Install (Installieren).

HINWEIS Wenn Sie eine LAN-Verbindung verwenden oder von einer GPIB- auf eine LAN-Verbindung 
umsteigen, müssen Sie den Agilent BootP-Dienst mit ChemStation (Version B.04.02) 
verwenden, um Geräten eine IP-Adresse zuzuweisen, die sich keine eigenen IP-Adressen 
zuweisen können. Der CAG BootP-Server wird nicht unterstützt. Deinstallieren Sie 
zunächst den CAG BootP-Server, bevor Sie mit der Installation von Agilent BootP beginnen.
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10 Die Dateien werden geladen. Anschließend wird der Bildschirm BootP 
Settings (BootP-Einstellungen) angezeigt.

• Der Bildschirm BootP Settings (BootP-Einstellungen) enthält die 
unkonfigurierten Vorgabewerte. Diese Einstellungen werden während 
der Konfiguration eingegeben.

• Verifizieren Sie die TCP/IP-Einstellungen mit dem Dienstprogramm 
IPCONFIG. Öffnen Sie hierzu ein Befehlszeilenfenster und geben Sie 
ipconfig/all ein.

11 Aktivieren Sie das Kontrollkästchen Do you want to log BootP requests? 
(Möchten Sie BootP-Anforderungen protokollieren?).

Das Kontrollkästchen Do you want to log BootP requests? (Möchten Sie 
BootP-Anforderungen protokollieren?) muss deaktiviert werden, wenn die 
Konfiguration der Geräte abgeschlossen ist, da die Protokolldatei 
anderenfalls sehr schnell viel Speicherplatz in Anspruch nehmen würde.

12 Tragen Sie im Bereich Default Settings (Standardeinstellungen) des 
Bildschirms die Subnetzmaske und das Gateway ein. Fragen Sie Ihren 
Netzwerk-Administrator, wenn Sie die Subnetzmaske und das Gateway 
nicht kennen.

• Die Standard-Subnetzmaske ist 255.255.255.0.

• Das Standard-Gateway ist 10.1.1.101.
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13 Klicken Sie auf OK. Der Bildschirm Agilent BootP Service Setup (Agilent 
BootP-Dienst – Setup) wird angezeigt.

14 Klicken Sie auf Finish (Fertig stellen), um den Bildschirm Agilent BootP 
Service Setup (Agilent BootP-Dienst – Setup) zu schließen.

15 Entnehmen Sie die DVD aus dem Laufwerk.

Damit ist die Installation abgeschlossen.

Sie können die Readme-Datei für den Agilent BootP-Dienst drucken. Diese 
Datei befindet sich im Verzeichnis „C:\Programme\Gemeinsame Dateien\
Agilent Shared\BootP\bin\Readme.htm“. 

Geräten IP-Adressen mit dem Agilent BootP-Dienst zuweisen

Der Agilent BootP-Dienst ist für die Verknüpfung eines eindeutigen ID-Codes 
(MAC-Adresse) der auf einem bestimmten Gerät installierten LAN-Karte mit 
der diesem Gerät zugewiesenen IP-Adresse verantwortlich. Daher muss diese 
Verknüpfung definiert oder neu definiert werden, sobald ein neues Gerät 
hinzugefügt, ein vorhandenes Gerät (oder seine LAN-Karte) ausgetauscht 
oder die einem Gerät zugewiesene IP-Adresse geändert wird.

Geräte mit dem Agilent BootP-Dienst konfigurieren

1 Ermitteln Sie die MAC-Adresse des GCs, auf dem die JetDirect-Karte 
installiert ist, mit einem der folgenden Schritte:

• Agilent BootP-Dienst (siehe Schritt 2)

• JetDirect-Karte (siehe Schritt 3)

2 So ermitteln Sie die MAC-Adresse des GCs mit dem Agilent BootP-Dienst:

a Schalten Sie den GC aus und wieder ein.

b Wenn der GC seinen Selbsttest abgeschlossen hat, öffnen Sie die 
Protokolldatei in einem Editor. 

• Der Standardspeicherort der Protokolldatei lautet „Arbeitsplatz\
Lokale Festplatte\Programme\Gemeinsame Dateien\Agilent Shared\
BootP\bin\logfile“.

• Die Protokolldatei wird nicht aktualisiert, wenn sie geöffnet ist.

• Weisen Sie nur den Geräten eine Adresse zu, die sich selbst keine 
Adresse zuweisen können. Weitere Informationen hierzu finden Sie in 
der Dokumentation des jeweiligen Geräts.
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Der Inhalt ähnelt dem folgenden Beispiel:

02/25/04 15:30:49 PM 
Status: BootP Request received at outermost layer 
Status: BootP Request received from hardware address: 0010835675AC  
Error:   Hardware address not found in BootPTAB: 0010835675AC 
Status: BootP Request finished processing at outermost layer 

c Notieren Sie die angezeigte MAC-Adresse (z. B. 0010835675AC). 
Wird auch als Hardware-Adresse bezeichnet.

d Schließen Sie die Protokolldatei, bevor Sie ein weiteres Gerät 
einschalten. 

e Wechseln Sie zu Schritt 4.

3 So ermitteln Sie die MAC-Adresse des GCs mit einer JetDirect-Karte:

a Schalten Sie das Gerät aus.

b Nehmen Sie die JetDirect-Karte heraus.

c Notieren Sie sich die MAC-Adresse aus dem entsprechendem Feld.

Die MAC-Adresse befindet sich auf einem Etikett auf der der Komponente 
abgewandten Seite der JetDirect-Karte. Die Adresse befindet sich 
unterhalb des Strichcodes und hinter dem Doppelpunkt (:). In der Regel 
beginnt sie mit den Buchstaben AD. 

d Setzen Sie die Karte wieder ein.

e Schalten Sie den GC ein.

4 Fügen Sie das GC-Gerät zum Netzwerk hinzu.

a Wählen Sie Start > Alle Programme > Agilent BootP Service und 
anschließend Edit BootP Settings (BootP-Einstellungen bearbeiten). 
Der Bildschirm BootP Settings (BootP-Einstellungen) wird angezeigt.

b Deaktivieren Sie das Kontrollkästchen Do you want to log BootP requests? 
(Möchten Sie BootP-Anforderungen protokollieren?).

Das Kontrollkästchen Do you want to log BootP requests? (Möchten Sie 
BootP-Anforderungen protokollieren?) muss deaktiviert werden, wenn 
die Konfiguration der Geräte abgeschlossen ist, da die Protokolldatei 
anderenfalls sehr schnell viel Speicherplatz in Anspruch nehmen würde.

c Klicken Sie auf Edit BootP Addresses... (BootP-Adressen bearbeiten).

d Klicken Sie auf Add... (Hinzufügen). Der Bildschirm Add BootP Entry 
(BootP-Eintrag hinzufügen) wird angezeigt.
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e Nehmen Sie für den GC folgende Einträge vor:

• MAC-Adresse

• Host-Name

• IP-Adresse

• Anmerkung, falls erforderlich

• Subnetzmaske

• Gateway-Adresse

f Klicken Sie auf OK.

g Schließen Sie den Bildschirm „BootP Manager“ (BootP-Manager) 
und schalten Sie den GC aus und wieder ein.

Beim Ändern der IP-Adresse muss das Gerät aus- und wieder 
eingeschaltet werden, damit die Änderungen wirksam werden.

h Führen Sie zur Überprüfung der IP-Adresse einen Ping auf die Adresse aus.

5 Fügen Sie ein zusätzliches Gerät zum Netzwerk hinzu.

a Wiederholen Sie Schritt 4 für alle Geräte im Netzwerk, die den 
BootP-Dienst benötigen.

b Klicken Sie anschließend auf Close (Schließen).

c Klicken Sie auf OK.



24 Installation Ihrer ChemStation

1 Vorbereitung der Installation

Agilent BootP-Dienst konfigurieren

Der Agilent BootP-Dienst wird automatisch beim Neustart des PCs gestartet. 
Zum Ändern der Einstellungen des Agilent BootP-Diensts müssen Sie den 
Dienst stoppen, die Änderungen vornehmen und den Dienst anschließend neu 
starten. Führen Sie zum Konfigurieren des Agilent BootP-Diensts folgende 
Schritte aus.

Agilent BootP-Dienst beenden

1 Wählen Sie in der Windows-Systemsteuerung Verwaltung > Dienste. 
Der Bildschirm Dienste wird angezeigt.

2 Klicken Sie mit der rechten Maustaste auf Agilent BootP Service 
(Agilent BootP-Dienst).

3 Wählen Sie Beenden.

4 Schließen Sie die Bildschirme „Dienste“ und „Verwaltung“.
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Einstellungen bearbeiten

1 Wählen Sie Start > Alle Programme > Agilent BootP Service und anschließend 
Edit BootP Settings (BootP-Einstellungen bearbeiten). Der Bildschirm BootP 
Settings (BootP-Einstellungen) wird angezeigt.

2 Wenn der Bildschirm BootP Settings (BootP-Einstellungen) zum ersten 
Mal geöffnet wird, werden die Standardeinstellungen aus der Installation 
angezeigt.

Tabellendatei erstellen

Sie können eine neue Vorlage für die Tabellendatei erstellen, indem Sie 
Create Tab File (Tabellendatei erstellen) wählen.

Die bei der Installation erstellte Standard-Tabellendatei befindet sich im 
Verzeichnis „C:\Programme\Gemeinsame Dateien\Agilent Shared\BootP\
bin\TabFile“. Sie enthält die Konfigurationsangaben dieses Bildschirms.

Die Protokolldatei konfigurieren

Aktivieren Sie das Kontrollkästchen Do you want to log bootP requests? (Möchten 
Sie BootP-Anforderungen protokollieren?), um alle Anforderungen an das 
GC-System mitsamt der MAC-Adresse zu protokollieren. Deaktivieren Sie 
das Kontrollkästchen Do you want to log bootP requests? (Möchten Sie 
BootP-Anforderungen protokollieren?), wenn die Konfiguration der Geräte 
abgeschlossen ist, damit die Protokolldatei nicht so viel Speicherplatz in 
Anspruch nimmt.

Die bei der Installation erstellte Standardprotokolldatei befindet sich im 
Verzeichnis „C:\Programme\Gemeinsame Dateien\Agilent Shared\BootP\
bin\logfile“. Sie enthält einen Eintrag für jede BootP-Anfrage eines Geräts 
nach Konfigurationsangaben.

Agilent BootP-Dienst neu starten

1 Wählen Sie in der Windows-Systemsteuerung Verwaltung > Dienste. 
Der Bildschirm Dienste wird angezeigt.

2 Klicken Sie mit der rechten Maustaste auf Agilent BootP Service 
(Agilent BootP-Dienst) und wählen Sie Starten.

3 Schließen Sie die Bildschirme „Dienste“ und „Verwaltung“.

Hiermit ist die Konfiguration abgeschlossen.
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Die Agilent GPIB-Schnittstellenkarte installieren und konfigurieren

Wenn Sie keine GPIB-Kommunikation verwenden, überspringen Sie diesen 
Abschnitt.

GPIB-Schnittstellenkarte installieren und konfigurieren

Weitere Informationen zur Installation der GPIB-Schnittstellenkarte finden 
Sie in Ihrem Computer-Handbuch. Sie können aber auch die folgenden 
Schritte ausführen.

1 Schalten Sie Ihren Computer aus, ziehen Sie den Netzstecker heraus und 
entfernen Sie dann die Abdeckung(en) des Computers.

2 Wählen Sie einen freien PCI-Steckplatz für die GPIB-Karte. Nach dem 
Anschließen des GPIB-Kabels treten möglicherweise Störungen auf, wenn 
die Karte in den letzten Steckplatz des PCs gesteckt wird.

3 Lösen Sie die Befestigungsschraube an der Abdeckplatte des Steckplatzes 
und entfernen Sie sie.

4 Fassen Sie die Karte an den Kanten an und stecken Sie sie in den 
Steckplatz. Stellen Sie sicher, dass die Kontaktleiste der Karte fest sitzt. 
Befestigen Sie die Karte mit der Befestigungsschraube.

5 Befestigen Sie die Abdeckungen des Computers. Schließen Sie die 
Kabelverbindungen an und starten Sie den Computer.

6 Wenn Sie die GPIB-Karte in den Computer eingesetzt haben, müssen der 
zugehörige Treiber und die Konfigurationssoftware installiert werden. 
Diese befinden sich auf der Agilent ChemStation-DVD im Verzeichnis 
„Agilent I/O Library Suite“. Weitere Informationen hierzu finden Sie im 
Handbuch „Agilent I/O Library Suite Installation Guide“, das sich auf der 
ChemStation-DVD im Ordner „Support\Manuals\Installation“ befindet.

WARNUNG Schalten Sie Ihren Computer aus und ziehen Sie den Netzstecker des PCs und aller 
angeschlossenen Geräte heraus, bevor Sie Gehäuseteile entfernen. Stellen Sie 
sicher, dass Sie bei der Installation der GPIB-Karte eine antistatische Manschette 
tragen.
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GPIB-Verkabelung

Beachten Sie bei der Verbindung von GPIB-Geräten folgende Regeln:

• Schalten Sie den Computer und alle angeschlossenen Geräte wenn möglich 
immer aus und ziehen Sie die Stromkabel ab, bevor Sie die GPIB-Kabel 
einstecken.

• Stellen Sie anhand der mit jedem Analysengerät gelieferten Dokumentation 
dessen GPIB-Adresse fest, bevor Sie es anschließen. Es ist nicht möglich, 
dass zwei Geräte dieselbe Adresse haben. Notieren Sie die vergebenen 
Adressen. Diese Informationen werden später benötigt.

• Verwenden Sie nach Möglichkeit kurze GPIB-Kabel von 2 m Länge oder 
weniger. 
 
Kabel (0,5 m) (Teilenr. 10833D) 
Kabel (1,0 m) (Teilenr. 10833A) 
Kabel (2,0 m) (Teilenr. 10833B) 
Kabel (4,0 m) (Teilenr. 10833C)

• Schließen Sie das GPIB-Kabel an den GPIB-Anschluss des Computers an. 
Stellen Sie sicher, dass alle GPIB-Stecker fest miteinander verbunden sind. 
Lockere Steckverbindungen erzeugen Fehler, die nur schwer zu finden sind.

• Verbinden Sie die GPIB-Geräte in einer Kette. Eine Kette wird aufgebaut, 
indem ein GPIB-Gerät mit dem folgenden und dieses wiederum mit dem 
nächsten usw. verbunden wird. Vermeiden Sie sternförmige Konfigurationen 
(bei denen mehrere Geräte über einen zentralen Punkt miteinander 
verbunden sind).

VORSICHT GPIB-Verlängerungskabel werden von der Agilent ChemStation nicht unterstützt.
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In diesem Kapitel wird Folgendes beschrieben:

• Den PC für die Installation der neuen Agilent ChemStation-Software 
einrichten

• Die Agilent ChemStation erstmalig installieren

• Gerätelizenzen bei der Erstinstallation eingeben

• Ein Gerät bzw. eine Gerätelizenz zu einer vorhandenen Agilent 
ChemStation hinzufügen

• Ein Upgrade der Agilent ChemStation ausführen
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Bevor Sie beginnen

Konfigurieren Sie Ihren PC vor der Installation der Agilent 
ChemStation-Software wie folgt:

1 Stellen Sie sicher, dass der PC die Mindestanforderungen erfüllt.

2 Richten Sie die Gerätekommunikation wie unter Kapitel 1 beschrieben ein.*

3 Melden Sie sich bei Ihrem PC mit Windows-Administratorrechten an.

4 Öffnen Sie in der Systemsteuerung Ihres Systems die Regions- und 
Sprachoptionen. Wählen Sie in der Registerkarte Regionale Einstellungen die 
Sprache „Englisch (USA)“. Wenn Sie eine andere Sprache verwenden, sind 
die folgenden Einstellungen obligatorisch:

• Dezimaltrennzeichen = . (Punkt)

• Symbol für Zifferngruppierung = , (Komma) 

• Listentrennzeichen = , (Komma)

Klicken Sie auf die Registerkarte Advanced (Erweitert) und stellen Sie für 
Nicht-Unicode-Programme die Sprache „Englisch (USA)“ ein.

5 Deaktivieren Sie die erweiterten Einstellungen zur Energieverwaltung Ihres 
Computers, z. B. den Standby- und den Ruhemodus.

Weitere Informationen zum Optimieren von Vorgängen unter Windows XP 
oder Windows Vista finden Sie in den Anweisungen, die im Dokument 
Configure and Maintain Your Agilent ChemStation Computer enthalten sind. 
Dieses Dokument steht als PDF-Datei auf der Agilent ChemStation-DVD zur 
Verfügung. In diesem Dokument sind die erforderlichen Systemeinstellungen 
für eine optimale Leistung der Agilent ChemStation beschrieben.

* Dies gilt nicht für die Agilent ChemStation-Software für die Datenanalyse.

HINWEIS Wenn Sie ein Upgrade der Agilent ChemStation-Software ausführen, sind auf Ihrem 
System vor der Installation der neuen Software möglicherweise Änderungen an der 
Hardware oder am Betriebssystem erforderlich. Weitere Informationen sowie ausführliche 
Anweisungen dazu, wie Sie Ihren PC für das Upgrade vorbereiten, finden Sie im Dokument 
Upgrade Preparation Guide for Agilent ChemStation B.04.02. Die Dokumentation steht 
sowohl gedruckt als auch als PDF-Datei im Verzeichnis „Manuals“ auf der Agilent 
ChemStation-DVD zur Verfügung.
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Installationsverfahren

Lesen Sie eins der folgenden Themen, je nachdem, welche Art von Installation 
Sie durchführen:

• „Erstinstallation“  auf Seite 31

• „Aktualisieren der Software (auf B.04.02)“  auf Seite 36

Erstinstallation

Im Folgenden wird beschrieben, wie Sie die Agilent ChemStation-Software 
zum ersten Mal installieren.

Anweisungen zum Hinzufügen eines Geräts zu Ihrer vorhandenen Agilent 
ChemStation-Software finden Sie auf Seite 37. Anweisungen zum Upgrade 
und zur erneuten Installation Ihrer Agilent ChemStation-Software finden 
Sie auf Seite 36.

Gehen Sie bei der Erstinstallation der Agilent ChemStation-Software wie 
folgt vor:

1 Stellen Sie sicher, dass Sie alle unter „Bevor Sie beginnen“  auf Seite 30 
beschriebenen Schritte ausgeführt haben.

2 Stellen Sie sicher, dass auf Ihrem System keine Programme geöffnet sind.

3 Wenn Sie ein Upgrade Ihrer ChemStation durchführen, stellen Sie sicher, 
dass Sie die Methoden-, Sequenzen-, Datendateien- und 
Säulen-Datenbanken (6890COL.MDB, CATALOG.MDB, 6850COL.MDB, and 
6850CAT.MDB) vor dem Upgrade an einem anderen Speicherort sichern.

4 Legen Sie die DVD der Agilent ChemStation-Software in das 
DVD-Laufwerk ein. 

5 Wählen Sie im Startmenü Ausführen.

6 Geben Sie an der Befehlszeile Laufwerk:\Install\Setup.exe (z. B., E:\Install\
Setup.exe) ein und klicken Sie auf OK. Der Installationsassistent wird 
gestartet.

HINWEIS Die Säulen-Datenbanken für die GC ChemStation befinden sich im Ordner „C:\Chem32\
drivers“.
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7 Akzeptieren Sie die Eingabeaufforderungen des Installationsassistenten 
im ersten Teil der Installation.

• Es wird empfohlen, das Standardverzeichnis „C:\Chem32“ anzugeben, wenn 
Sie aufgefordert werden, das Agilent ChemStation-Installationsverzeichnis 
festzulegen.

• Wenn Microsoft.NET Framework 2.0 nicht auf Ihrem Computer 
installiert ist, werden Sie dazu aufgefordert, dieses zu installieren. 
Wechseln Sie hierzu in das Verzeichnis „dotNET Framework“ auf der 
ChemStation-DVD und führen Sie die Datei „dotnetFx.exe“ aus. 
Wiederholen Sie anschließend die Schritte 5, 6 und 7.

• Wenn Microsoft.NET Framework 3.5 SP1 nicht auf Ihrem Computer 
installiert ist, werden Sie dazu aufgefordert, dieses zu installieren. 
Für die Installation von .Net 3.5 SP1 muss der Computer möglicherweise 
neu gestartet werden.

• Gegebenenfalls werden Sie zur Installation der PDF-Druckersoftware 
aufgefordert. Dieser Drucker ist erforderlich und wird verwendet, 
um Reports im PDF-Format auszugeben.

8 Konfigurieren Sie mithilfe des Einrichtungsassistenten die Anzahl und 
den Typ der Geräte. Klicken Sie auf der linken Bildschirmseite auf eine 
der Schaltflächen, um ein Gerät hinzuzufügen.
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• Sie können bis zu vier Geräte hinzufügen, indem Sie auf die entsprechenden 
Schaltflächen klicken. (Für jedes Gerät wird eine Lizenz benötigt.) 

• Wenn Sie ein Datenanalysengerät auswählen, nachdem bereits ein GC- 
oder LC-Gerät ausgewählt wurde, werden alle vorherigen Einstellungen 
verworfen.
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9 Geben Sie die erforderlichen Lizenzen ein, sobald die Gerätetypen 
hinzugefügt wurden.

Geben Sie die entsprechende Lizenznummer in das dafür vorgesehene 
Feld ein und klicken Sie auf Add (Hinzufügen). Anstelle des Textfelds wird 
anschließend der Schlüssel neben dem angezeigten Modulnamen angezeigt. 
Pro Gerätetyp wird nur eine Komplettlizenz benötigt.

Beachten Sie bei der Eingabe von Lizenzen für verschiedene Gerätetypen 
(z. B. GC, A/D oder LC), dass die Art der Lizenz, die hier für jedes Gerät 
festgelegt wird, die Konfiguration des entsprechenden Geräts bestimmt. 
Wenn Sie beispielsweise für Instrument 1 (Gerät 1) eine GC-Lizenz 
eingeben, muss das entsprechende Gerät als GC konfiguriert werden.

10 Klicken Sie auf Finish (Fertig stellen), um den Einrichtungsassistenten zu 
schließen. Der Konfigurationseditor wird automatisch angezeigt.

HINWEIS Wenn eine ungültige Lizenz oder eine Lizenz vom falschen Typ eingegeben wird, ändert sich 
die Farbe des Texteingabefelds von Schwarz zu Rot. Zusätzlich wird in einer Meldung 
angezeigt, dass die Lizenz nicht akzeptiert wurde.

HINWEIS Der Computer muss nicht neu gestartet werden.
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11 Führen Sie die Anweisungen in den Bildschirmen des Konfigurationseditors 
aus. Weitere Informationen zur Konfiguration der Geräte finden Sie in 
Kapitel 3, „Gerätekonfiguration“. 

12 Wählen Sie nach der Konfiguration der Geräte File > Save 
(Datei/Speichern).

13 Schließen Sie den Konfigurationseditor.

14 Wenn Sie die Software installiert und die Geräte konfiguriert haben, 
bewahren Sie die ChemStation-Produkt-DVD und die Lizenznummern 
an einem sicheren Ort auf. Sie werden benötigt, wenn Sie die Software 
erneut installieren oder ein neues Gerätemodul bzw. eine Lizenz hinzufügen 
möchten.
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Aktualisieren der Software (auf B.04.02)

Wenn Sie ChemStation B.01.01 oder höher aktualisieren möchten, lesen Sie 
die Anleitung Upgrade Quick Reference Guide (Upgrade-Kurzanleitung). 
Diese befindet sich auf der Agilent ChemStation-DVD im Verzeichnis 
„Manuals“. Speichern Sie die Methoden-, Sequenzen-, Datendateien- 
und Säulen-Datenbank für jedes Gerät, bevor Sie eine neue Installation 
durchführen.

Die Säulen-Datenbanken für die GC ChemStation befinden sich im 
Unterordner „\drivers“, z. B. „C:\Chem32\drivers“.

XML-basierte Schnittstelle aktivieren

Wenn Sie ein LIMS- oder anderes externes Datenerfassungssystem 
verwenden, bietet die Agilent ChemStation eine XML-Schnittstelle. Über diese 
Schnittstelle können Sie Probeneingabelisten einlesen, die Proben analysieren 
und anschließend die Ergebnisdaten auf dem LIMS-System ausgeben. 
Um diese Funktionalität zu aktivieren, müssen Sie Änderungen an der Datei 
„CHEMSTATION.INI“ vornehmen. Weitere Informationen hierzu finden Sie im 
Handbuch Agilent ChemStation Plus XML Connectivity Guide, das sich auf 
der Agilent ChemStation-DVD im Verzeichnis „\Support\Manuals“ befindet. 

HINWEIS Vor dem Upgrade müssen alle Service Releases und Add-On-Produkte für die ChemStation 
deinstalliert werden. Weitere Informationen hierzu finden Sie in der Anleitung Upgrade 
Quick Reference Guide (Upgrade-Kurzanleitung).
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Geräte zu einer vorhandenen Installation hinzufügen

So fügen Sie ein Gerät zu einer vorhandenen Installation hinzu:

1 Wählen Sie Programs > Agilent ChemStation > Add Instrument 
(Programme/Agilent ChemStation/Gerät hinzufügen). Der 
Einrichtungsassistent der ChemStation wird geöffnet.

• Konfigurierte Geräte können nicht geändert oder gelöscht werden.

• Eine einzelne ChemStation-Installation unterstützt maximal 4 Geräte.

2 Führen Sie Schritt 8 bis Schritt 10 aus (siehe Seite 32).

3 Führen Sie nach dem Hinzufügen von Geräten einen IQT-Report aus, um die 
ChemStation zu überprüfen. Siehe „IQT-Validierungsverfahren ausführen“  
auf Seite 57.
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Kontrollkarten-Reports installieren

Mit dem im Folgenden beschriebenen Verfahren werden Kontrollkarten 
zum Reportmenü hinzugefügt.

Um diese Funktion nutzen zu können, muss Microsoft Excel 2000, XP oder 
2003 auf Ihrem PC installiert sein.

Wenn Sie Agilent ChemStation installiert und das PC-System neu gestartet 
haben, können Sie die ChemStation-Funktion für Kontrollkarten installieren.

1 Starten Sie die Agilent ChemStation.

2 Suchen Sie die Agilent ChemStation-Befehlszeile. Die Befehlszeile ist ein 
Texteingabefeld unten im Programmfenster der Agilent ChemStation.

3 Geben Sie an der Befehlszeile MACRO STARTCHT.MAC,GO ein und drücken 
Sie die Eingabetaste.

4 Es wird ein Dialogfeld mit Informationen zur Installation angezeigt.

5 Klicken Sie in diesem Dialogfeld auf Help (Hilfe), um Informationen zur 
Verwendung von Kontrollkarten auf der Agilent ChemStation anzuzeigen.

6 Klicken Sie auf OK, um die Kontrollkarten-Funktion auf der Agilent 
ChemStation zu installieren. 
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In diesem Kapitel wird beschrieben, wie Sie den Konfigurationseditor zum 
Konfigurieren der Geräte für die Agilent GC ChemStation, die ChemStation 
für die Datenanalyse und die 35900E A/D ChemStation verwenden. 
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Allgemeines zum Agilent ChemStation Configuration Editor

Der Agilent ChemStation Configuration Editor ist ein Programm, das die 
Konfiguration der Agilent ChemStation-Software vereinfacht. Dies umfasst:

• Erkennen der GPIB-Schnittstellenkarte auf dem PC

• Auswahl der LAN- oder GPIB-Kommunikation

• Konfigurieren der Analysengeräte, die am Computer angeschlossen sind

• Konfigurieren der Pfadnamen, die für Methoden, Daten und Sequenzen 
benötigt werden

• Konfigurieren der Farben der Agilent ChemStation

Sie benötigen den Konfigurationseditor in folgenden Fällen:

• Im letzten Schritt der erstmalig ausgeführten Installation für die Agilent 
ChemStation-Software

• Jedes Mal, wenn Sie ein GPIB-Gerät ändern, an den GPIB-Bus oder den 
PC anschließen oder von diesen trennen

• Jedes Mal, wenn Sie die IP-Adresse eines LAN-Geräts ändern, und immer 
dann, wenn Sie ein LAN-Gerät zur ChemStation-Software hinzufügen oder 
von dieser entfernen

Nach der Installation der Agilent ChemStation-Software müssen Sie das 
komplette Analysensystem konfigurieren.
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Agilent ChemStation für die GC-Systeme 7890A, 6890, 6850 und 
5890/4890 konfigurieren

Führen Sie nach der Installation der ChemStation-Software die folgenden 
Schritte aus, damit die Agilent ChemStation die vorhandene Hardware 
erkennen und steuern kann.

1 Rufen Sie den Konfigurationseditor auf, falls dieser noch nicht geöffnet ist. 
Klicken Sie hierzu auf > Alle Programme > Agilent ChemStation > Configuration 
Editor. Markieren Sie im Begrüßungsbildschirm des Konfigurationseditors 
die Titelleiste eines Geräts, das mit einer GC-Lizenz installiert wurde, und 
wählen Sie Configure > Instruments... (Konfigurieren/Geräte). Der Bildschirm 
Select Instrument (Gerät auswählen) wird angezeigt. 

2 Wählen Sie in der Liste „Instrument Type“ (Gerätetyp) das Gerätemodell 
aus (z. B. 7890A GC). Beachten Sie folgende Ausnahmen:

• Wählen Sie zum Steuern eines Agilent 6890 oder 6850 GC, der einen ALS 
der Serie 7683, 7673C oder keinen ALS enthält, den Eintrag 6890 GC 
(Classic) oder 6850 GC (Classic).

• Wählen Sie zum Steuern eines Agilent 6890 oder 6850 GC, der einen ALS 
der Serie 7693A enthält, den Eintrag 6890 GC oder 6850 GC. 

Titelleiste

Configure > Instruments 
(Konfigurieren/Geräte)
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• Um einen 4890D GC zu steuern, wählen Sie 5890 GC. 

3 Übernehmen Sie den Gerätenamen oder geben Sie im Feld „Instrument 
Name“ (Gerätename) einen neuen Namen ein. Der in diesem Feld 
eingegebene Name wird in der Titelleiste angezeigt, wenn Sie die Agilent 
ChemStation verwenden.

4 Legen Sie unter „Initial Screen Window Size“ (Anfängliche 
Bildschirmgröße) fest, wie das Programm geöffnet werden soll. 

5 Klicken Sie auf OK, um fortzufahren. 

6 Geben Sie im Bildschirm Device Configuration (Gerätekonfiguration) 
die erforderlichen Werte ein.  

Legen Sie den Typ der Verbindung zwischen Ihrem PC und diesem Gerät 
fest:

• LAN (IP) + IP-Adresse

• LAN (Host) + Host-Name

• GPIB + GPIB-Adresse 

Schritt 2

Schritt 3

Schritt 4
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Bei einigen GC-Typen wird das Feld Port Address (Port-Adresse) angezeigt. 
Sofern nicht anders angegeben, übernehmen Sie den Standard-Port 9100.

7 Konfigurieren Sie optionale Geräte.

• So konfigurieren Sie den Probengeber 7673 auf einem 5890/4890 GC: 
Wenn ein Probengeber 7673 an ein 5890/4890 GC angeschlossen ist, 
markieren Sie im Feld „Options (Optionen) den Eintrag „7673 Sampler“ 
(Probengeber 7673), geben Sie die GPIB-Adresse im dafür vorgesehenen 
Feld ein und klicken Sie anschließend auf Add (Hinzufügen).
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• So konfigurieren Sie eine 35900E Zweikanal-Schnittstelle als einen 
oder zwei GC-Detektoren:Wenn ein 35900E A/D an einem 6890, 6850 
oder 5890 GC angeschlossen ist, um zusätzliche Signale zu steuern, 
markieren Sie im Feld „Options“ (Optionen) den Eintrag „35900E“ 
und klicken Sie auf Add (Hinzufügen). Geben Sie anschließend den 
Schnittstellentyp und die Kanäle in den entsprechenden Feldern ein 
und klicken Sie auf OK. 

8 Klicken Sie im Bildschirm Device Configuration (Gerätekonfiguration) auf OK, 
um zum Hauptfenster des Konfigurationseditors zurückzukehren, wie in 
Schritt 1 dargestellt.

9 Klicken Sie auf File > Save (Datei/Speichern).

10 Klicken Sie auf File > Exit (Datei/Beenden), um zu Windows zurückzukehren.
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Agilent ChemStation für Datenanalysensysteme konfigurieren

Führen Sie nach der Installation der ChemStation-Software folgendes 
Verfahren aus, damit die Agilent ChemStation das vorhandene 
Datenanalysensystem erkennen und steuern kann.

1 Rufen Sie den Konfigurationseditor auf, falls dieser noch nicht geöffnet ist. 
Klicken Sie hierzu auf > Alle Programme > Agilent ChemStation > Configuration 
Editor. Markieren Sie im Begrüßungsbildschirm des Konfigurationseditors 
die Titelleiste des entsprechenden Geräts und wählen Sie Configure > 
Instruments... (Konfigurieren/Geräte). Der Bildschirm Select Instrument 
(Gerät auswählen) wird angezeigt. 

HINWEIS Ändern Sie für Konfigurationen des Typs „Data Analysis Only“ (Nur Datenanalyse) 
in den Standardeinstellungen des Konfigurationseditors nur den Gerätenamen, 
sofern erforderlich (Schritt 3). 
„Gerät 1“ muss als Gaschromatograph (Nur GC- oder A/D-Datenanalyse) und 
„Gerät 2“ als Flüssigkeitschromatograph (Nur LC-Datenanalyse) definiert sein.

Titelleiste

Configure > Instruments 
(Konfigurieren/Geräte)



46 Installation Ihrer ChemStation

3 Gerätekonfiguration

2 Wählen Sie in der Liste „Instrument Type“ (Gerätetyp) den Eintrag GC or 
A/D Data Analysis only (Nur GC- oder A/D-Datenanalyse).  

3 Übernehmen Sie den Gerätenamen oder geben Sie im Feld „Instrument 
Name“ (Gerätename) einen neuen Namen ein. Der in diesem Feld 
eingegebene Name wird in der Titelleiste angezeigt, wenn Sie die Agilent 
ChemStation-Software verwenden. 

4 Legen Sie unter „Initial Screen Window Size“ (Anfängliche 
Bildschirmgröße) fest, wie das Programm geöffnet werden soll. 

5 Klicken Sie auf OK, um fortzufahren. 

6 Klicken Sie auf File > Save (Datei/Speichern).

7 Klicken Sie auf File > Exit (Datei/Beenden), um zu Windows zurückzukehren.

Schritt 2

Schritt 3

Schritt 4
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Agilent ChemStation für 35900E A/D-Schnittstellensysteme konfigurieren

In diesem Abschnitt wird die Konfiguration der 35900E-Analog-zu-Digital- 
Schnittstelle beschrieben. Beachten Sie, dass die 35900E A/D-Schnittstelle 
den Agilent BootP-Dienst benötigt (siehe „Agilent BootP-Dienst installieren“  
auf Seite 18).

1 Rufen Sie den Konfigurationseditor auf, falls dieser noch nicht geöffnet ist. 
Klicken Sie hierzu auf > Alle Programme > Agilent ChemStation > Configuration 
Editor. Markieren Sie im Begrüßungsbildschirm des Konfigurationseditors 
die Titelleiste eines Geräts, das mit einer 35900E A/D-Lizenz installiert 
wurde, und wählen Sie Configure > Instruments... (Konfigurieren/Geräte). Der 
Bildschirm Select Instrument (Gerät auswählen) wird angezeigt. 

2 Wählen Sie in der Liste „Instrument Type“ (Gerätetyp) das zu steuernde 
Gerät 35900E ADC aus. 

Titelleiste

Configure > Instruments 
(Konfigurieren/Geräte)

Schritt 2

Schritt 3

Schritt 4
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3 Übernehmen Sie den Gerätenamen oder geben Sie im Feld „Instrument 
Name“ (Gerätename) einen neuen Namen ein. Der in diesem Feld 
eingegebene Name wird in der Titelleiste angezeigt, wenn Sie die Agilent 
ChemStation verwenden.

4 Legen Sie unter „Initial Screen Window Size“ (Anfängliche 
Bildschirmgröße) fest, wie das Programm geöffnet werden soll. 

5 Klicken Sie auf OK, um fortzufahren.

6 Wählen Sie den Schnittstellentyp und geben Sie anschließend die 
IP-Adresse oder den Host-Namen ein.

7 Wenn Agilent ChemStation Signale erfassen soll, wählen Sie die 
zu verwendenden Kanäle aus. Im obigen Beispiel ist eine Kanal 
(A)-Konfiguration dargestellt. Weitere Informationen hierzu finden 
Sie im 35900E-Benutzerhandbuch. 

8 Wenn Agilent ChemStation einen Probengeber steuert, klicken Sie im 
Gruppenfeld „Sampler“ (Probengeber) auf Change... (Ändern). Wählen Sie 
im Dialogfeld „Sampler“ (Probengeber) unter „Sampler Type“ 
(Probengebertyp) die Option Other (Sonstige) und nehmen Sie für die 
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verbleibenden Elemente die entsprechenden Einstellungen vor. Klicken Sie 
auf OK.

9 Wählen Sie unter „External Start/Stop“ (Externes Starten/Stoppen) und dem 
Status „Ready“ (Bereit) die gewünschten Optionen aus. Sie können das 
Dialogfeld öffnen, indem Sie im Gruppenfeld „External Start/Stop“ (Externes 
Starten/Stoppen) auf Change (Ändern) klicken. Dieses Dialogfeld enthält die 
Optionen für das Starten/Stoppen und den Bereit-Status für den 35900.

a Wählen Sie unter den drei verfügbaren Optionen für das 
Starten/Stoppen die gewünschte Option aus.

b Wählen Sie die entsprechenden Systemstatusoptionen.

• Aktivieren Sie das Feld ChemStation displays status of ready signal 
(ChemStation zeigt Status des Bereit-Signals an), wenn die Agilent 
ChemStation auf dem Bildschirm ein Statussignal anzeigen soll, 
sobald das Gerät betriebsbereit ist.
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• Aktivieren Sie das Feld ChemStation waits for ready signal (ChemStation 
wartet auf Bereit-Signal), wenn die Agilent ChemStation auf ein 
Signal vom Gerät warten soll, bevor es mit der automatischen 
Verarbeitung beginnt. 

c Um zum Dialogfeld „Device Configuration“ (Gerätekonfiguration) 
zurückzukehren, klicken Sie auf OK.

10 Konfigurieren Sie die 35900-Tasten. Im Dialogfeld „35900 Buttons“ 
(35900-Tasten) legen Sie fest, ob mit den Tasten des vorderen Bedienfelds 
auf der 35900-Schnittstelle ein Analysenlauf manuell gestartet oder 
gestoppt werden kann. Um das Dialogfeld „35900 Buttons“ (35900-Tasten) 
im Gruppenfeld „35900 Buttons“ (35900-Tasten) zu öffnen, klicken Sie auf 
Change (Ändern).

a Wählen Sie die gewünschten Optionen für die Start- und Stopptasten für 
den 35900 aus.

b Um zum Dialogfeld „Device Configuration“ (Gerätekonfiguration) 
zurückzukehren, klicken Sie auf OK.

11 Prüfen Sie die zeitgesteuerten Ereignisse. Um zeitgesteuerte Ereignisse 
für den 35900E im Gruppenfeld„Define Events“ (Ereignisse definieren) 
zu definieren, klicken Sie auf Change (Ändern).

• Wenn Sie den 35900E im Remote-Bus-Modus (Standardeinstellung) 
verwenden, überspringen Sie diesen Abschnitt. Dieser Abschnitt bezieht 
sich nicht auf Ihre Konfiguration.

• Wenn Sie den 35900E im programmierbaren digitalen E/A-Modus 
verwenden, können Sie 16 zeitgesteuerte Ereignisse auf der Agilent 
ChemStation festlegen. Zunächst müssen Sie jedoch den AUSDRUCK 
eingeben, den Sie für jedes Ereignis definieren möchten. Gehen Sie 
hierzu wie im Folgenden beschrieben vor.
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• Jeder Ausdruck definiert den aktiven Zustand (z. B. geöffnet) und den 
inaktiven Zustand (z. B. geschlossen) für jedes Gerät, das Sie mit dem 
35900E steuern. Anschließend können Sie einen Zeitplan für diese 
Ereignisse festlegen, indem Sie die im Dialogfeld „Defined Events“ 
(Definierte Ereignisse) der Agilent ChemStation eingegebenen 
Ausdrücke verwenden.

In Abbildung 1 werden die Pins 7 bis 9 als benutzerdefinierte 
Einstellungen und die Pins 2 bis 6 als Standardeinstellungen angezeigt.

Abbildung 1  Beispielbildschirm „Define Events“ (Ereignisse definieren)

VORSICHT Die Korrelation zwischen dem zugewiesenen Ausdruck und der Polnummer bzw. dem 
Polstatus, mit der bzw. dem er verknüpft ist, wird in der Definitionsdatei des Geräts 
gespeichert. Bei dieser Methode wird nur der AUSDRUCK selbst (z. B. „Close Valve 1“ 
[Ventil 1 schließen]) gespeichert und verwendet. Wenn Sie also eine Methode von 
einer Agilent ChemStation auf eine andere kopieren und die zweite Agilent 
ChemStation zwar einen übereinstimmenden Ereignisausdruck enthält, aber über 
unterschiedliche Geräte verfügt, können unvorhersehbare Ergebnisse auftreten. Daher 
sollten die Verknüpfungen zwischen einem Gerät und einem Ereignisausdruck in Ihrer 
jeweiligen Hardware-Konfiguration eindeutig sein.



52 Installation Ihrer ChemStation

3 Gerätekonfiguration

a Geben Sie den zu verwendenden AUSDRUCK ein, um den inaktiven 
Zustand (high = hoch) und den aktiven Zustand (low = niedrig) des ersten 
Geräts zu definieren. Sie können eine beliebige Kombination von Zeichen 
und Zahlen verwenden (maximal 20). 
 
Wenn Sie beispielsweise ein normal schließendes Ventil steuern möchten 
(ein Ventil, das nur bei Zufuhr von Energie geöffnet wird), könnten Sie 
einen Ausdruck wie in Abbildung 1 auf Seite 51 verwenden. Dieser 
Ausdruck gibt an, dass das Ventil normal geschlossen ist (der Status „high“ 
entspricht „Geschlossen“) und bei Zufuhr von Energie in den Status 
„Opened“ (Geöffnet) wechselt (der Status „low“ entspricht „Geöffnet“). 
 
Sie können bei Bedarf auch einen expliziteren Ausdruck zuweisen, z. B. 
Close Nitrogen Valve (Stickstoffventil schließen) und Open Nitrogen Valve 
(Stickstoffventil öffnen).

b Wiederholen Sie den in Schritt (a) beschriebenen Vorgang für alle 
weiteren Geräte, die Sie steuern möchten.

c Um zum Dialogfeld „Device Configuration“ (Gerätekonfiguration) 
zurückzukehren, klicken Sie auf OK.

12 Stellen Sie sicher, dass die im Dialogfeld „Device Configuration“ 
(Gerätekonfiguration) angezeigten Informationen richtig sind. Um eine der 
Optionen zu ändern, klicken Sie im entsprechenden Gruppenfeld auf Change 
(Ändern).

13 Schließen Sie das Dialogfeld „Device Configuration“ (Gerätekonfiguration). 
Um zum Hauptbildschirm des Konfigurationseditors zurückzukehren, 
klicken Sie auf OK.

14 Speichern Sie die neue Gerätekonfiguration. Wählen Sie File > Save 
(Datei/Speichern). 

15 Wenn Sie ein weiteres Gerät konfigurieren möchten, wählen Sie dieses aus 
und fahren Sie fort. Wenn dies das einzige Gerät ist, wählen Sie File > Exit 
(Datei/Beenden).
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Pfadangaben für Ihre Methoden, Sequenzen und Datendateien

Der Konfigurationseditor ermöglicht die Angabe verschiedener Pfadnamen für 
Ihr Gerät sowie für Ihre Sequenzen, Methoden, Datendateien und Gerätemakros. 
So können Datensätze auf einem separaten Laufwerk gespeichert werden.

Führen Sie die folgenden Schritte aus, um verschiedene Pfade für ein Gerät zu 
konfigurieren.

1 Bevor Sie die Pfadangaben mit dem Konfigurationseditor ändern, müssen 
Sie die entsprechenden Verzeichnisse anlegen.

2 Markieren Sie die Titelleiste des zu ändernden Geräts.

3 Wählen Sie im Menü „Configuration“ (Konfiguration) den Eintrag Paths 
(Pfade). Wählen Sie im nun angezeigten Dialogfeld einen Dateityp aus, den 
Sie für dieses Gerät ändern möchten: „Sequence Files“ (Sequenzdateien), 
„Data Files“ (Datendateien), „Methods“ (Methoden), „Macro Path“ 
(Makropfad) oder „Instrument Path“ (Gerätepfad).

4 Bearbeiten Sie den Pfad im Feld „New Path“ (Neuer Pfad) und klicken Sie 
anschließend auf die Eingabetaste.

• Alle Pfadnamen müssen mit einem umgekehrten Schrägstrich (\) 
eingegeben werden.

• Wiederholen Sie diesen Vorgang für jeden gewünschten Pfad.

5 Bei Auswahl von OK werden die Pfadangaben aktualisiert. Anschließend 
wird wieder der Konfigurationseditor angezeigt.

In Tabelle 4 werden die Standarddateipfade aufgeführt.

Tabelle 4 Standardpfade der Datendateien

Einstellung Standarddateipfad

Sequenzdateien C:\CHEM32\1\SEQUENCE\

Datendateien C:\CHEM32\1\DATA\

Methoden C:\CHEM32\1\METHODS\

Makropfad C:\CHEM32\CORE

Gerätepfad C:\CHEM32\1\
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In diesem Kapitel wird beschrieben, wie Sie das Agilent ChemStation- 
Dienstprogramm zur Installationsqualifizierung (Installation Qualification 
Report, IQT) verwenden, um eine reibungslose Installation und den 
ordnungsgemäßen Betrieb der Agilent ChemStation auf Ihrem PC zu 
validieren. Außerdem wird beschrieben, wie Sie die Agilent ChemStation 
nach der Validierung der Installation erstmalig verwenden.
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IQT-Applikation

Nach der Installation der Dateien der ChemStation-Software auf Ihrem PC 
und der Konfiguration des Analysensystems können Sie anhand einer 
internen Validierung den Ablauf der Installation prüfen und die 
Einsatzbereitschaft des Analysensystems verifizieren. Zusätzlich überprüft 
das IQT-Dienstprogramm den Versionscode der ausführbaren Systemdateien 
(*.EXE, und *.DLL) und die Referenzdateien der Agilent ChemStation.

Das IQT-Dienstprogramm der Agilent ChemStation verwendet werkseitig 
mitgelieferte Referenzdateien, um das Vorhandensein, die Richtigkeit und die 
Integrität der benötigten Agilent ChemStation-Systemdateien (ausführbare 
Programmdateien, binäre Registerdateien, Makrodateien, Initialisierungsdateien, 
Hilfedateien, benutzerfreundliche Reportvorlagen) zu prüfen. 

Die Dateiintegrität wird durch den Vergleich der Prüfsumme der installierten 
Dateien (Cross-Redundancy-Check, CRC) mit der Prüfsumme der Originaldateien, 
die im Installationsmuster von Agilent Technologies abgelegt sind, festgestellt. Die 
Details der Master-Installationsdatei sind in den Referenzdateien aufgeführt. 
Veränderte oder beschädigte Dateien haben unterschiedliche Prüfsummen, 
weshalb sie vom IQT-Dienstprogramm erkannt werden.

Die Integrität der Referenzdateien selbst wird ebenso mithilfe von 
Kontrollsummen ermittelt. Wenn das IQT-Dienstprogramm mit einer nach 
ihrer Generierung geänderten Referenzdatei ausgeliefert wird, wird dies im 
Report angezeigt (unter der Überschrift invalid reference files [ungültige 
Referenzdateien]).

Wie bei jeder wichtigen Aktualisierung der ChemStation-Software empfiehlt 
Agilent, dass Sie nach der Installation von Version B.04.02 eine vollständige 
IQT-, Funktions- und Leistungsprüfung (OQ/PV) durchführen, um die 
Richtigkeit und Vollständigkeit der Installation zu überprüfen.
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IQT-Validierungsverfahren ausführen

Das IQT-Dienstprogramm der Agilent ChemStation wird automatisch mit den 
entsprechenden IQT-Referenzdateien installiert.

So führen Sie die Validierung aus:

1 Stellen Sie sicher, dass alle Agilent ChemStation-Software-Programme 
geschlossen sind, bevor Sie das IQT-Dienstprogramm ausführen.

2 Klicken Sie auf Start > Alle Programme > Agilent ChemStation > IQT Report.

Die Prüfsummenberechnung für alle Agilent ChemStation-Systemdateien 
kann mehrere Minuten dauern. 

3 Das Agilent ChemStation IQ Tool erstellt eine HTML-Datei mit den 
Qualifizierungsergebnissen (iqtreport.hmt) im Hauptverzeichnis von 
ChemStation (in der Regel c:\chem32). Dieser Report wird automatisch im 
Internetbrowser des Systems angezeigt. Bei einer kompletten und fehlerfreien 
Installation wird bei der Installationsqualifizierung keine Fehlermeldung 
ausgegeben und im Report werden keine Dateien als fehlend oder verändert 
aufgeführt. Der Report kann vom Browser aus gedruckt werden.

Installationsqualifizierungs-Report

Der IQT-Report enthält die in Tabelle 5 aufgeführten Dateikategorien:

Tabelle 5 Von der IQT-Applikation angegebene Dateikategorien 

Dateikategorie Erklärung Erforderliche Handlung

Identische 
Dateien

Die benötigten Dateien sind vorhanden 
und haben die Versions- und 
Integritätsüberprüfung bestanden.

Keine Aktion notwendig.

Fehlende Dateien Es fehlen Dateien, die zum Betrieb der 
Agilent ChemStation benötigt werden.

Reparieren Sie die Agilent 
ChemStation-Software oder 
installieren Sie sie erneut.
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Abbildung 2 und Abbildung 3 enthalten Beispiele für IQT-Ergebnisse. In 
Abbildung 2 war die Installation erfolgreich. In Abbildung 3 hat die 
Installation die Prüfung nicht bestanden, weil eine Datei fehlt und eine 
weitere Datei geändert wurde.

Geänderte 
Dateien

Dateien wurden beschädigt oder 
verändert.*

Reparieren Sie die Agilent 
ChemStation-Software oder 
installieren Sie sie neu, es sei denn, 
Sie haben Agilent ChemStation- 
Dateien absichtlich geändert oder 
aktualisiert. 

Ungültige 
Referenzdatei

Die Originalreferenzdatei ist 
beschädigt oder wurde nach Ihrer 
Erstellung verändert.

Wiederherstellen der ursprünglichen 
Referenzdatei.

* Wenn Sie ein Upgrade der Agilent ChemStation durchgeführt haben, ohne zuvor alle Add-Ons 
entfernt zu haben, tritt bei der IQT ein Fehler auf. Entfernen Sie die Add-Ons zunächst, wie in 
Upgrade Quick Reference Guide (Upgrade-Kurzanleitung) beschrieben. Diese befindet sich auf der 
Agilent ChemStation-DVD im Verzeichnis „Manuals“ (Handbücher). Reparieren Sie die 
ChemStation-Software anschließend oder installieren Sie sie erneut.

Abbildung 2 Beispiel für einen IQT-Report ohne Fehler

Tabelle 5 Von der IQT-Applikation angegebene Dateikategorien (Fortsetzung)

Dateikategorie Erklärung Erforderliche Handlung
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Abbildung 3 Beispiel für einen IQT-Report mit Fehlern
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Funktionsqualifizierung/Leistungsprüfung (OQ/PV)

Der OQ/PV-Dienst von Agilent liefert den schriftlichen Nachweis darüber, dass 
Ihre neue ChemStation-Software gemäß den vorgegebenen Leistungsparametern 
funktioniert. Er prüft die ordnungsgemäße Funktion des Integrationsalgorithmus 
im Rahmen der Chromatographie-Leistungsprüfung. Außerdem prüft er so 
wichtige Bereiche wie die Gerätekommunikation und -steuerung sowie die 
Datensicherheit und die Zugriffssteuerung.

Um sicherzustellen, dass die ChemStation-Software gemäß den vorgegebenen 
Leistungsparametern funktioniert, wählen Sie in der Datenanalyse-Ansicht 
der Applikation View > Verification > Run Test (Ansicht/Verifizierung/Test 
ausführen). Der Leistungsprüfungstest des Systems wird automatisch 
ausgeführt.

• Wählen Sie Run Test (Test ausführen) in der Ansicht Verification (Verifizierung) 
und führen Sie den Verifizierungstest mit dem Namen default.val durch.

• Nähere Informationen hierzu finden Sie in der Online-Hilfe im Abschnitt 
„Analysenaufgaben“.
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Dieses Kapitel enthält einen Überblick über zusätzliche Agilent ChemStation- 
Ressourcen, die Sie auf der Agilent ChemStation-DVD und unter 
www.agilent.com/chem finden.
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Agilent Technologies Servicecenter 

Das Servicecenter löst Probleme und maximiert die Leistung

Das Agilent Netzwerk der Servicecenter ermöglicht Ihnen Zugang zu 
Fachpersonal, das Ihnen bei der Lösung von Schwierigkeiten bei der Bedienung 
der Geräte und der Analysen-Software von Agilent Technologies behilflich ist. 
Normalerweise erfolgt die Unterstützung durch das Servicecenter über das 
Telefon, sie kann aber auch auf ferngesteuerte Unterstützung via Modem 
ausgedehnt werden, sofern Sie Agilent dazu ermächtigen. 

Die Dauer der Unterstützung kann zu sehr günstigen Konditionen auf 
ein Jahr oder um zwei Jahre erweitert werden. Im Rahmen dieses 
Support-Angebots erhalten Sie einen Anspruch auf telefonische Hilfe, 
automatische Software-Upgrades sofort nach Erscheinen und die regelmäßige 
Lieferung des Software Status Bulletins mit wichtigen Informationen 
zu bekannten Problemen und verfügbaren Ausweichlösungen. Weitere 
Informationen zur Inanspruchnahme dieser Services erhalten Sie bei 
Ihrem lokalen Agilent Kundendienstvertreter.

Dieser informiert Sie über verfügbare Kundendienstleistungen wie Beratung, 
kundenspezifische Systemanpassungen, Entwicklung und Schulungen zu 
Analysen-Softwareprodukten von Agilent.

Sie erhalten die Unterstützungs- und Update-Services zu den in Ihrem Land 
bei der Bestellung gültigen Preisen und Vertragsbedingungen.
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Beim Agilent Technologies LSCA Servicecenter anrufen

Wenn Sie beim Agilent Technologies Servicecenter anrufen, sollten Sie an 
Ihrem Computer sitzen und die Produktdokumentation zur Hand haben.

Es wird empfohlen, die unten aufgeführten Informationen bereitzuhalten:

• Das Etikett des Registrierungspakets mit der Produktnummer, dem 
Versionscode und der Lizenzregistrierungsnummer Ihrer Analysen-Software.

• Den genauen Wortlaut der aufgetretenen Fehlermeldung(en).

• Einen vollständigen Ausdruck der Windows Systeminformationen.

• Eine Beschreibung der Umstände, unter denen der Fehler aufgetreten ist.
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Inhalt der Agilent ChemStation-DVD

Die DVD der Agilent ChemStation enthält zusätzliche aktualisierte 
Informationen, die bei der Installation der Software auf Ihrem System 
hilfreich sein können. Weitere Informationen finden Sie bei Bedarf in 
folgenden Dateien.

Agilent ChemStation-Module

Die DVD enthält die ausführbaren Dateien für alle Module der Agilent 
ChemStation-Produktgruppe. Für die Installation eines Moduls benötigen 
Sie eine gültige Lizenzregistrierungsnummer. Diese Nummer hebt den 
Schutz auf der DVD auf. Die entsprechenden Nummern werden mit Ihrem 
Originalprodukt mitgeliefert und dienen als Lizenznachweis.

Für die Erstinstallation der Agilent ChemStation-Module befindet sich 
im Hauptverzeichnis der Agilent ChemStation-DVD eine Verknüpfung zum 
Konfigurationsprogramm (setup.exe). Anschließend können zusätzliche 
Module durch Auswahl von Start > Alle Programme > Agilent ChemStation > 
Add Instrument (Gerät hinzufügen) hinzugefügt werden.

Agilent ChemStation Software Status Bulletin

Das Software Status Bulletin (SSB) ist ein Dokument, in dem die Ergebnisse 
der Agilent Fehlerprotokollierung, -verfolgung und -behebung aufgeführt sind. 
Das SSB befindet sich auf der Agilent ChemStation-DVD im Verzeichnis 
„Support\SSB“.

Wenn Sie über einen Software-Vertrag verfügen, erhalten Sie das Agilent 
ChemStation Software Status Bulletin automatisch.

Agilent ChemStation-Versionsüberblick

Der Versionsüberblick ist für Anwender gedacht, die ihr analytisches System 
nach einer Aktualisierung auf eine neue Version der Anwendersoftware 
möglicherweise überprüfen müssen. Der Versionsüberblick enthält die Versionen 
aller Produkte, die Teil der Agilent ChemStation-Produktfamilie sind.

Die vorherigen Dateiversionen befinden sich auf der Agilent 
ChemStation-DVD im Verzeichnis „Support\History“.

Das erste Thema der Online-Hilfe enthält eine Übersicht über die Änderungen.
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Benutzergestützte Bibliothek

Der Inhalt dieser Bibliothek soll Benutzern helfen, die Installation für ihre 
spezifischen Anforderungen zu entwickeln und anzupassen, sodass sie ihre 
Investition bestmöglich nutzen können.

Der Inhalt der Bibliothek stammt sowohl von Agilent Mitarbeitern als auch 
von Benutzern. Jeder Beitrag wird auf Funktionalität hin überprüft. Dabei 
werden jedoch nicht notwendigerweise dieselben formalen Testverfahren wie 
für das eigentliche Produkt verwendet. Agilent Technologies übernimmt daher 
keine Gewährleistung für die Richtigkeit der Beiträge.

Die benutzergestützte Bibliothek umfasst Dienstprogramme und Makros. 
Jeder Beitrag wird mit einer separaten README.TXT-Datei geliefert, die 
in einem beliebigen Texteditor geöffnet werden kann.

I/O-Bibliotheken für die Agilent GPIB-Schnittstelle

Die Agilent ChemStation-DVD enthält eine Version der I/O-Bibliotheken, die 
erfolgreich mit dieser Version der Agilent ChemStation getestet wurde. Die 
I/O-Bibliotheken müssen separat installiert werden, um in Verbindung mit 
GPIB-Geräten verwendet werden zu können, wie im Handbuch Agilent IO 
Libraries Suite 15.0 or higher Installation and Configuration Instructions 
beschrieben.

Agilent BootP-Dienst

Auf der Agilent ChemStation-DVD befindet sich das Setup-Programm für den 
Agilent BootP-Dienst, mit dessen Hilfe den Analysegeräten, die an ein LAN 
angeschlossen sind, eine IP-Adresse und Konfigurationsparameter zugewiesen 
werden können. Der Agilent BootP-Dienst ist für die Benutzung von 
Analysengeräten mit einer LAN-Verbindung einfach zu konfigurieren. Weitere 
Informationen zum BootP-Dienst finden Sie unter „Agilent BootP-Dienst 
installieren“ auf Seite 18.

Agilent ChemStation-Produktdokumentation

Die Produktdokumentation für die Agilent ChemStation besteht aus gedruckten 
Handbüchern zum Nachschlagen und einer themenbezogenen Online- 
Dokumentation. Elektronische Versionen aller ChemStation-Handbücher 
befinden sich auch auf der DVD im Verzeichnis „Manuals“.
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Lehrmittel

Zum Lieferumfang der Agilent ChemStation-Software, des PCs und der Geräte 
gehören zahlreiche Lehrmittel. 

Dokumente

• In diesem und in anderen Installationshandbüchern wird beschrieben, 
wie Sie die Agilent ChemStation für den Betrieb vorbereiten, indem Sie die 
erforderliche Hard- und Software installieren. Für die unterschiedlichen 
Module, die in die Agilent ChemStation integriert werden können, stehen 
entsprechende Installationshandbücher zur Verfügung. Zum Lieferumfang 
gehören daher möglicherweise mehrere Handbücher.

• Das Handbuch Understanding Your ChemStation (Wissenwertes zur 
ChemStation) beschreibt die Agilent ChemStation-Konzepte, mit denen Sie 
Ihre Kenntnisse über die Funktionsweise der Agilent ChemStation vertiefen 
können.

• Im Online-Handbuch für die Makroprogrammierung wird beschrieben, wie 
Sie mit leistungsstarken Befehlen die Funktionen der Agilent ChemStation 
anpassen und erweitern können. Wählen Sie im Hilfemenü die Option 
„Commands“ (Befehle), um auf dieses Online-Handbuch zuzugreifen.

• Die XML-Schnittstelle ist vollständig im Handbuch Agilent ChemStation 
Plus XML Connectivity Guide dokumentiert, das auf der Agilent 
ChemStation-DVD im Verzeichnis „Manuals“ als PDF-Dokument vorliegt.

Informationen zum Setup und zur Wartung

• Eine Readme-Datei enthält Angaben zu neuen Funktionen, bekannten 
Möglichkeiten zur Fehlerbehebung und Korrekturen, die zum Zeitpunkt des 
Drucks nicht mehr in die gedruckte Version des Handbuchs aufgenommen 
werden konnten. Die Datei „readme.txt“ kann über Start > Alle Programme > 
Agilent ChemStation > readme.txt. aufgerufen werden.

• Ein automatisch aktualisiertes Logbuch enthält etwaige 
Fehlerbedingungen, die während des Betriebs erkannt wurden, und 
entsprechende Gegenmaßnahmen (sofern erforderlich). Sie können auf 
diese Daten zugreifen, indem Sie im Menü View“ (Ansicht) den Eintrag 
Logbook (Logbuch) auswählen und auf die gewünschten Einträge 
doppelklicken. Die neuesten Einträge befinden sich oben in der Liste.
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Agilent ChemStation-Hilfesystem

Das Agilent ChemStation-Hilfesystem bietet unter den folgenden 
Menüeinträgen eine umfassende Datenbank mit Informationen:

• ChemStation Tutorial enthält eine Beschreibung der Software und der 
allgemeinen Aufgaben, sodass Sie sich mit den Grundlagen des Systems 
vertraut machen können.

• How to Work with Your ChemStation enthält Anweisungen für die Arbeit 
mit der Agilent ChemStation. Sie lernen, wie Sie Aufgaben für die 
Methoden- und Analysensteuerung, die Datenanalyse, das Reportlayout, 
die Verifizierung (OQ/PV) und Diagnoseansichtsfunktionen ausführen.

• User Interface Reference enthält eine ausführliche Beschreibung aller 
Elemente in den Menüs, Symbolleisten und Dialogfeldern der Agilent 
ChemStation-Software. Die Beschreibungen sind nach den 
unterschiedlichen Agilent ChemStation-Ansichten sortiert. 

• Concepts of ChemStation enthält Informationen zu ausgewählten 
Konzepten der Agilent ChemStation-Software wie Integration, 
Kalibrierung, Kalibrierungsreporttypen, Spektrenverarbeitung und 
Peak-Parameter.

• In Error Messages werden alle Fehlermeldungen aufgelistet, die auftreten 
können, einschließlich möglicher Ursachen und Gegenmaßnahmen. 

• Troubleshooting enthält Informationen, die Ihnen bei der allgemeinen 
Problembehebung mit der Agilent ChemStation helfen können.

• Commands enthält eine umfassende Liste der Befehle sowie den Namen, 
die Gruppe, die Syntax, die Parameter, die Diskussion, den Rückgabewert 
und Beispiele (sofern möglich) von unterschiedlichen Aufgaben in der 
Agilent ChemStation-Software.

• Macros enthält das Handbuch Macro Programming Guide, in dem der 
Zweck und die grundlegende Struktur eines Makros beschrieben wird. 
Außerdem erfahren Sie, wie Makros mithilfe von Befehlszeilen-Strings 
geschrieben werden. Mit Makros können Sie die Agilent 
ChemStation-Software optimal an Ihre Anforderungen anpassen.
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Agilent Lab Advisor Software

Eine umfassende Sammlung an zusätzlichen Online-Informationen, Videos, 
Büchern und vieles mehr ist in der Agilent Lab Advisor Software enthalten.

Mit der Lab Advisor Software lassen sich Abläufe in einem Labor 
automatisieren. Neben hardwarespezifischen Videos und Dokumentation 
bietet sie folgende Funktionen:

• Überwachung von mehreren Analysengeräten in Echtzeit

• Überwachung der Routinewartung einschließlich Aufzeichnung

• Warnung bei möglicherweise erforderlichem Service, bevor Probleme 
auftreten

• Durchführung von Diagnosetests und Kalibrierungen

Weitere Informationen

Weitere Informationen finden Sie auf der Agilent Webseite unter 
www.agilent.com/chem.
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